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SESSION 1 
Introduction to Movie 

Maker 
In this session, students are introduced to video production techniques. To 

begin, they view two sample videos of modern-day nursery rhymes including a 

new "spin" on Humpty Dumpty and Little Boy Blue. Afterwards, students study 

the Movie Maker workspace to gain familiarity with the program environment. 

Once they understand they layout of the window and some key terms, they 

learn how to use the program to video edit. By importing the raw footage used 

to make the Little Boy Blue sample, students create their own video production 

by deleting unwanted frames, adding video effects, applying transitions, and 

inserting text overlays. The goal of this session is to have students understand 

how they can use Movie Maker to produce their own modern-day nursery 

rhyme. 

Assignment 1: A New "Spin" on an Old Favorite 

Assignment 2: An Introduction to Movie Maker 

Assignment 3: Learn How to Video Edit 

 

Session 1 Review: Getting to Know Movie Maker 

Session 1 Skill Review: One Picture Digital Story 

Session 1 Extension Activity: Thinking About Nursery Rhymes 
 

  

Each TechnoKids project 
contains 6 sessions. Although 
teaching time may vary, each 
assignment takes about 20 
minutes to complete. 

TechnoKids Inc.
Typewritten Text
Learn more about TechnoDrama

http://www.technokids.com/Store/Elementary-School/TechnoDrama/digital-storytelling-in-the-classroom.aspx
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Session 1: Introduction to Movie Maker 

Getting Started 

Overview 

In this session, students are introduced to video production techniques. To begin, they view two 

sample videos of modern-day nursery rhymes including a new "spin" on Humpty Dumpty and Little 

Boy Blue. Afterwards, students study the Movie Maker workspace to gain familiarity with the 

program environment. Once they understand they layout of the window and some key terms, 

they learn how to use the program to video edit. By importing the raw footage used to make the 

Little Boy Blue sample, students create their own video production by deleting unwanted frames, 

adding video effects, applying transitions, and inserting text overlays. The goal of this session is to 

have students understand how they can use Movie Maker to produce their own modern-day 

nursery rhyme. 
 

Materials 

 Windows Media Player 

 Movie Maker  

 Movie Maker Flashcards (Optional)  

o Home Tab, Animations Tab, Visual Effects Tab, Video Tools Edit Tab, Text Tools 

Format Tab, Movie Maker Button 

 Drama Folder 

o Humpty video 

o Boy Blue video 

 Session 1 Review (Optional) 

 Session 1 Skill Review (Optional) 

o Jump picture 

o Jump edit sample file 
 

Teacher Preparation  

(Refer to the Preparing to Teach section of this guide for instructions) 

 Make the Drama folder available to students.  

 Determine a location for students to save their work during this project. 

 (Optional) Print the flashcards listed in the materials list for this session.  

 

Teaching Strategy 

In this project, students produce their own digital story. Explain scenario to students. 
 

Do you remember any of the nursery rhymes you were taught as a small child? Most of 

them are very silly and often make no sense. Now is your chance to make things clear. 

You, along with a small group of your classmates, are given the opportunity to choose 

your favorite rhyme and put a new "spin" on it, give it a new meaning or clarify an existing 

one. Using props, puppets, actors and your imagination, you will film a new version of the 

rhyme. 

For every session, the Teacher Guide 
features:  
 an introduction with a materials list 
 preparation advice 
 teaching strategies 
 lesson plans for each assignment 
 learning objectives for the session 



SAMPLE
TECHNODRAMA 

 

1-2  TECHNOKIDS INC. 

 

In this session, students edit a sample video to learn how to use video editing tools. Explain 

scenario to students. 

 

In this session, you watch two sample videos of modern-day nursery rhymes. When you 

watch them look for how the stories were put together. This should give you some ideas 

for what you want to do when you make your own video. 

 

Once you have finished looking at the samples, you will learn how to edit a video. Using 

Movie Maker you will delete frames, add video effects, apply transitions, and insert text 

overlays. Be sure to "click around" to learn what you can and cannot do with this 

software. This will help you when you make your own modern day nursery rhyme. 

 

 

Assignment 1 A New "Spin" on an Old Favorite 

 

In this assignment, students view sample "modern-day" nursery rhymes including Humpty 

Dumpty, Little Boy Blue, and Hey Diddle Diddle. They analyze the content of the stories to notice 

the action, characters, and props. They also study the production techniques used, such as the 

number of shots, video effects, transitions, text overlays, and narration. The purpose of this 

assignment is to offer students inspiration for when they create their own digital story. 

 

To begin, discuss nursery rhymes (a list of nursery rhymes is available in Assignment 5) 

 Make a list of nursery rhymes that students remember. 

 Ask questions about the rhymes such as: 

o Mary Had a Little Lamb: What would your teacher say if you brought a lamb to 

school? 

o Little Jack Horner: Would Jack's mom be happy if she knew he stuck his thumb in 

a pie? 

o Hickory Dickory Dock: What would you do if you saw a mouse run up a clock? 

o Rock-a-bye Baby: Why was the baby crib put up in a tree? 

 

 

Assignment 2 An Introduction to Movie Maker 

 

In this assignment, students are introduced to the Movie Maker environment. Consider having 

students rest the mouse over each part of the program window as you read aloud the name 

and function. 

 

 

 

 
 

  

Evaluation Tools for TechnoDrama 

To evaluate the TechnoDrama project, there are two tools in the Assessment folder within 

the Session 7 folder, both of which are customizable. One is a Summary of Skills checklist and 

the other is a rubric to assess both the group work portion of the project as well as the 

individual movie that will be created. Teachers may also choose to show the students the 

rubric in advance.  

This section explains each assignment 
and gives helpful tips for teachers. 
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Assignment 3 Learn How to Video Edit 

 

In this assignment, students edit the raw video footage used to make the Little Boy Blue video. 

During the video editing, encourage students to think about how they can use these program 

features to create their own digital story. The goal is to teach students the editing tools in Movie 

Maker including how to remove unwanted clips, add transitions, apply video effects, and insert 

text overlays. What is not discussed is how to record narration. This information is outlined in detail 

in Session 5. Define the following before you begin: 
 

 Shot: a single "take" that creates one video clip. 

 Video Effects: special effects that are applied to a shot to change the appearance. 

 Transitions: an effect that divides one shot from the other. 

 Text Overlay: words that are laid before, after, or over a shot. 

 Narration: the voice of a narrator talking while the action continues. 

 Frame: one piece of action in a shot. 

 

 

Lesson Plan 

Assignment 1 - A New "Spin" on an Old Favorite 

 An introduction to nursery rhymes. 

 View a digital story about Humpty Dumpty.  

 Analyze the content of the story including the action, characters, and props. 

 View a digital story about Little Boy Blue.  

 Analyze the production techniques to notice the number of shots, video effects, 

transitions, text overlays, and narration. 

 View a digital story based on Hey Diddle Diddle. 

 

Assignment 2 - An Introduction to Movie Maker 

 Discuss the capabilities of the program. 

 Open Movie Maker and label the parts of the window including Movie Maker button, 

ribbon, preview monitor, storyboard, playback controls and zoom time scale. 

 Close Movie Maker. 

 

Assignment 3 - Learn How to Video Edit 

 Open Movie Maker. 

 Add the 6 video clips that were used to make the digital story Little Boy Blue. 

 Remove the unwanted frames in shot 2. 

 Add video effects to a shot within the story. 

 Apply a transition between 2 shots within the story. 

 Add a text overlay to describe the story by typing text, selecting an animation, and 

formatting the appearance of the words. 

 Apply knowledge of Movie Maker to continue editing the story. 

 Save the project to a student folder as edit. Close Movie Maker. 

The Lesson Plan lists the individual 
steps in each assignment 
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Learning Objectives 

Below is a list of the learning objectives for this session. Students should be able to complete 

each task independently. 

 

Content Knowledge: 

 analyze the content of a digital story to notice action, characters, and props 

 analyze the production techniques used to make a digital story including the number 

of shots, video effects, transitions, text overlay, and narration 

 define the terms, shot, video effects, transitions, text overlay, frame, and narration 

 

Technical Skills: 

 

Operating Environment 

 open and close a program 

 save a document 

 label the parts of a program window 

 add a file 

 

Applied Technology 

 edit a video to remove unwanted frames, add transitions, apply video effects, and 

insert text overlays 

 use Windows Media Player to analyze a digital story 

 

Multimedia 

 delete unwanted frames 

 edit the font, style, color, and background of text 

 isolate a frame by clicking and dragging the playback indicator in the Storyboard 

 isolate a frame by clicking and dragging the slider in the Preview Monitor 

 isolate a frame by using the Previous Frame and Next Frame commands 

 import video clips into the Storyboard 

 play, stop, and pause a video file 

 preview an effect, animation, or transition  

 select an animation for the text overlay 

 split a clip into two or three clips 

 view, insert, and delete transitions, video effects, and text overlays  

 view a video in full screen 

 

 

 

 

 Learning Objectives are specified for each 
of the six sessions in the project. A 
checklist of all objectives is provided at 
the end of the project in Session 7. 
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Assignment 1: A New "Spin" on an Old Favorite 
 

 
 

 

When you heard or spoke nursery rhymes as a child, you loved them. But now that you are older 

you notice that they are pretty silly. Today when you read Humpty Dumpty you may wonder: 

 

 Why is Humpty Dumpty sitting on a wall? 

 What made Humpty Dumpty fall down? 

 Why were horses sent to fix Humpty Dumpty? Were they good at repairing broken eggs? 

 Did ALL the King's men need to rush to the wall to fix Humpty? Was it really that much of 

an emergency? 

 Who was Humpty and why was he so important that the King sent his men? 

 

Now you are to watch the Humpty video. It is a new "spin" on the old nursery rhyme. When you 

are done, answer the questions. 

 

 

 

Humpty Dumpty – A New Spin on an Old Rhyme 

 Double click the Drama shortcut or ask your teacher where the files are located.  

 Double click the Humpty video file. It opens in Windows Media Player and begins to play. 

To watch the video again, click the Play button. 

 
 

When you were small you may have heard nursery rhymes. A 

nursery rhyme is a poem for young children that can be spoken 

or sung. For example: 

 

Humpty Dumpty 
 

Humpty Dumpty sat on a wall, 

Humpty Dumpty had a great fall, 

All the King's horses, and all the King's men, 

Couldn't put Humpty together again. 

You are going to make a modern-

day video similar to this sample. 

 

Watch it to get ideas. 

Students begin by viewing sample 
completed projects. 
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1.  How is the story the SAME as the nursery rhyme? 

 Humpty Dumpty is sitting on a wall. 

 He falls from the wall. 

 The King's horses and men try to put him back together. 

 

The story gives more information than the original nursery rhyme. 

 

2.  Why did Humpty fall from the wall? 

 He was dancing to music on top of the wall and fell. 

  

 

 

3.  What happens at the end of the story? 

 The Queen wonders why horses tried to put together Humpty Dumpty and is  

 surprised that it was her idea. 

  

 

In this video, many things are done to tell the story. 

 

4.  What characters were used in the story? Check all that apply. 

  live actors 

  puppets or marionettes 

  still objects 

 

 

5.  How are the words used in the story? Check all that apply. 

  words on the screen 

  narrator 

  actor speaking 

 

 

6.  Look at the video. What props were used to tell the story? 

 Sheet for the background, castle wall, egg with pipe cleaner arms and legs, 

 Horses and knights, crown for the queen 

  

 

 

  

Questions inspire students to 
critically analyze the sample. 
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Little Boy Blue – A New Spin on an Old Rhyme 

 Little Boy Blue 

 

 Little Boy Blue come blow your horn. 

The sheep is in the meadow,  
The cow is in the corn. 

Where is the boy who looks after the sheep? 

He is under a haystack, fast asleep. 

 

 

 Double click the Drama shortcut or ask your teacher where the files are located. 

 Double click the boy blue video file. It opens in Windows Media Player 

and starts to play. To watch the video again, click the Play button.  

 

7.  What is the new "spin" on the story? 

 While boy blue was sleeping, the cows got away and now he has to catch them. 

  

 

 

Shots – a video has more than one "shot". A shot is a single "take" or acting part.  

When all the shots are put together, they tell a story. 

 

8.  How many "shots" or acting parts are in the video? 

 Six 

 (shot 1) little boy blue; (shot 2) sheep; (shot 3) cow; (shot 4) looking for boy blue; 

 (shot 5) sleeping boy blue; and, (shot 6) chasing the cow 

 

 

Video Effects – Movie Maker has many video effects that you can add to a shot to change the 

way it looks. You use them to make a shot look better. For example, you can brighten a dark 

video, play a shot in slow motion, or change the color of the video to black and white. 

 

9.  Watch the video. A slow motion video effect was added to the last shot. How does this 

effect make the story more interesting? 

 It adds drama to the chase scene.  

  

  

 

Now watch the Little Boy Blue video. It is a new "spin" on the 

old nursery rhyme. Many things were done in Movie Maker 

2012 to make the story. You are going to study the rhyme to 

notice how it was made. 

For the paperless classroom, 
students can answer the 
questions in their digital 
workbooks using the latest 
version of Adobe Reader. The 
Teacher Guide includes answers. 
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Transitions – A transition is an effect that divides one shot from the other.  

A transition should do two things. It should divide the story action and create interest. 

 

10.  What transitions were used in the video? Why were they a good choice? 

 Wipe down in the shape of a V – divides the shots of the two animals 

 Wheel – focus attention on boy blue sleeping 

 

Dissolve with small circles – divides the action to change the scene from boy blue 

sleeping to chasing the cow 

 Dissolve with fade – divides the end of the story from the credits 

 

Text Overlay – In a video, you can use a text overlay to tell your story. Text overlays are words 

that go before, after, or right on top of a shot to explain the action. Movie Maker also lets you 

animate the words so that they catch the viewer’s attention. 

 

11.  Watch the video. What text overlays are used? List as many as you can. 

 "Little Boy Blue" – title, "This is little boy blue" – bold words with the text animated in 

 the background. "The Farm Animals" – a banner on the page with the video in a  

 smaller frame, "Where is he?" – laid over the shot with the video showing through the 

 letters. "Sleeping" – ticker tape running at the bottom of the screen. "Oh No! The cows 

 are loose!" – words are in a shape that shows action or surprise. "COME BACK!" – words 

 are in a shape that shows the boy is yelling. "Little boy blue in in trouble now!" – a 

 banner on the page with the video pushed to the top. "THE END" – banner at the top 

 with credits rolling at the bottom. 

 

Narration – The voice that you hear while the action is taking place is that of the narrator.  

The purpose of narration is to tell a story or narrate an event or series of events. 

 

12.  Why is it a good idea to narrate this story? 

 Narrating and explaining the action is a great way to describe the story. 

  

 

Hey Diddle Diddle – A New Spin on an Old Rhyme 

 Hey Diddle Diddle 
 

Hey diddle diddle, 

The cat and the fiddle, 

The cow jumped over the moon.  

The little dog laughed, 

To see such sport, 

And the dish ran away with the spoon. 
 

 

Watch the Hey Diddle Diddle video. It is 

a new "spin" on the old nursery rhyme. 

How is it the same? How is it different? 
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Assignment 2: An Introduction to Movie Maker 
 

 

Open Movie Maker  

 Open Movie Maker.  

 

 

Label the Parts of the Program Window 

Read the descriptions. Then click around the Movie Maker program to find out the name of each 

part of the window. Once you know the name of each part, label the diagram: 

 

 Ribbon: Contains tabs that hold commands to perform tasks in the program. 

 Preview Monitor: Preview individual clips or an entire project.  

 Storyboard: Each video clip is displayed as a thumbnail in sequence. 

 Time Scale: Using the Zoom time scale, the clips can be viewed in smaller or larger time 

scale. This feature is useful in order to see the relative length in time of the shots.  

 Playback Controls: located below the Preview window. Play/Pause, Previous Frame, Next 

Frame. 

 

You are going to use Movie Maker 2012 to edit the 

raw footage used to make a video about Little Boy 

Blue. Before you can start, you need to be familiar 

with the parts of the program. 

1. Storyboard 

4. Time Scale 

2. Preview Monitor 

5. Ribbon 

3. Playback Controls 

Next, students are introduced to 
the Movie Maker window. 
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About Movie Maker  

Movie Maker is a program that can be used to create digital stories. It has many features that 

make it fun and easy to use, including: 

 Import photos and videos  

 Edit your movies 

 Edit the audio 

 Add a title, credits, or text onto a frame in the movie 

 Add sound to your movie that is automatically adjusted to the length of the video 

 Add transitions between frames 

 Take movies or pictures with your webcam or another device to include in your movie 

 Enhance your movie with a theme 

 Export and share your movie using various methods 

 

 

Close Movie Maker 

 Click Close. 

 

Questions about Video Editing Software or Apps 

 

1. a. Have you ever used Movie Maker?  yes  no 

   

 b. If yes, what did you create with it? 

   

   

   

2. a. What other video editing software or apps have you used? 

   

   

   

 If you have used other video editing software or apps answer these questions: 

  

 b. List the type of projects or videos you have created. 

   

   

   

   

   

 c. Does Movie Maker seem similar to software or apps you have used in the past? 
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Assignment 3: Learn How to Video Edit 
 

 
 

Open Movie Maker  

 Open Movie Maker. 

 
 

Add a Video Clip 

 On the Home tab, click Add videos and photos in the Add group. 

 

 In the Navigation pane, go to the Drama folder. 

 Double click to open the Edit folder. 

 Click to select the first video file. 

 Press and hold the SHIFT key on the keyboard and click to select the last video file. 

 
 

 Click Open. 

 

  

Learn how to use the tools in Movie Maker 2012 to edit the video footage from the Little 

Boy Blue story. 

 

The goal of this assignment is to learn what the program CAN 

 and CANNOT do. It is NOT to make a perfect story. 

 

Be sure to "click around" and try as many things as you can. 

Holding down the SHIFT key is 

one way to select all the files. 

In this assignment, students use 
video clips provided in the 
TechnoDrama resources to learn 
video editing skills. 
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Remove Unwanted Frames in a Shot 

 

 Click on shot 2 in the Storyboard area. 

 The first frame of this shot now appears in the Preview Monitor. 

 

 Click Play below the Preview Monitor. 

 

 Click Pause to stop the clip when the lamb starts to move. 

 
 

 

Position the Playhead 

 To position the play head in the correct location, you can either: 

o Click and drag the play head. Notice how the frame changes in the Preview Monitor. 

 
OR 

o Click the Previous Frame or Next Frame buttons. Notice how the frame changes in 

the Preview Monitor. 

 
  

When you make a video, you may record some things you do not want 

in the final video. If the problem is big, you may want to re-record it. But if 

the problem is small, such as a shaking camera or unwanted talking, 

these frames can be removed. 

 

A frame is one piece of action in the shot. In shot 2, the camera records 

some unwanted movement at the end of the shot. These frames need to 

be deleted. 

Notice that after you click 

Play, the button changes 

to Pause. 

Illustrated, step by step instructions 
include tool icons, sample window 
views, and helpful tips. 
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Split the Clip 

 
 

 Click the Video Tools Edit tab and find the Editing group. 

 
 

 Click Split. 

 The clip now appears as two clips in the Storyboard. 

 
 

 
 

 

 

 

 

Delete the Unwanted Clip 

 Click on the second shot 2 in the Storyboard. 

 Click Play in the Preview Monitor window to make sure that this has all the "bad" frames. 

 Click Pause to stop the video. 

 Make sure that the bad clip is still selected in the Storyboard and remove it by pressing 

DELETE on the keyboard. 

 
  

Once you have found the frame where things "start to go wrong" you will 

split the video into two pieces. The first piece has the frames you will want 

to keep while the second piece has the frames you can delete. 

This is where the play 

head was paused. 

Frames you 

want to keep. 

Frames you 

want to delete. 

One clip is now split into two 

clips at the pause mark. 

Now there is only one clip showing the lamb. It has 

been edited to remove the unwanted movement. 

Students can view each assignment 
as a digital file. 
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More arrow 

Add Video Effects to Attract Attention 

 

 Click the Visual Effects tab. 

 Click the More arrow to expand the Effects gallery. 

 

 REST your mouse over an effect to see a preview of the effect. (The effect will be 

previewed over a few seconds of the video where the play head is currently set.) 

 After you have looked at the types of effects available, find a place in your video where 

you would like to use it. 

 Click to apply the effect. 

 Then click Play to see how it looks. 

 Click Pause to stop the video. 

 

Remove an Effect 

 

 If you JUST applied the effect and decide you do not like it, click Undo on the Quick 

Access toolbar. 

 

 If it is several steps later, you will have to remove the effect manually. You may need to 

zoom in on the Storyboard to see the icon. Drag the slider to the right. 

 
  

Video effects are special effects that change the look of a 

shot. They can make a story look old, add movement, or 

improve the quality of the video. 

 

Pick a shot that you think NEEDS a video effect. They try 

different choices to find the one that looks the best. 

If you really are not happy with the effect and want to remove it 

you can! Whether it is a simple "undo" or you changed your mind 

after several other steps were added, try the methods below to 

remove the effect. 
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No effect 

More arrow 

 You will see a small icon at the start of the clip showing an effect has been added. 

 

 Click your mouse to select the clip. 

 Click the Visual Effects tab. 

 In the Effects group, choose No Effect.  

 

 

 
 

Add Transitions to Create Interest 

 

 Click Play and Pause or drag the play head to place it between clips where you would 

like to add a transition  

 Click the Animations tab and find the Transitions group. 

 Click the More arrow to expand the Transitions gallery. 

 

 REST your mouse over a transition to see a preview of what it does. (It will be previewed 

over a few seconds of the video where the play head is currently set.) 

 After you have looked at the transitions available, click to apply the one you want. 

 Then click Play to see how it looks. 

 Click Pause to stop the video.  

Transitions are effects that divide one shot from another. They are a 

great way to break up the story action and create interest. 

 

Pick a shot that you think NEEDS a transition. Then try different choices 

to find the one that looks the best. 

TIPS:  

 Scroll down to see the entire 

gallery of effects. 

 A triangle on the clip shows that 

a transition has been added. 

Students practice video editing in 
preparation for their project. They 
learn multimedia skills including how to: 
 import video clips 
 edit and animate text 
 delete unwanted frames 
 split clips 
 insert transitions 
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font 

styles 

Add a Text Overlay 

 
 

Place Text Before a Selected Clip 

 Click on the very first shot in the storyboard. 

 On the Home tab, find the Add group. 

 Click Title. 

 A blank frame is added before the selected clip. A text box is displayed with the default 

title "My Movie".  

 

 Click and drag to select the text and type Little Boy Blue to replace the words. 

 

Format the Title Text 

 

 In the Font group, choose a font type from the Font menu. 

 

Tell about the product and explain the story action with a text overlay. 

 

Text overlays are words that are placed before, after, or over a shot. This is 

a great way to add a title, credits, or explain the story action. 

 

Pick a shot that you think NEEDS a text overlay. Then choose an animation 

and format the words so that they look great! 

Notice that the Text Tools Format tab is now active in 

the ribbon. From here, you can format the text, adjust 

the amount of time it is displayed on the screen, and 

even add a visual effect. 

Font size 

Color and grow 

or shrink font 
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More arrow 

 Choose a font size. 

 Choose a style: Bold or Italic. 

 Choose a text color. 

 Change the size of the text using Grow font or Shrink font. 

 Click Play. 

 Click Pause. 

 

 

Add a Text Effect 

 Click the first clip in the storyboard to return to the beginning. 

 In the Effects group of the Text Tools Format tab, rest the mouse over an effect to see a 

preview on the title. 

 Click the More arrow to see more effects. 

 
 

 Click to apply an effect. 

 Click Play.  

 Click Pause. 

 

 

Adjust Background Color 

 Click the first clip in the storyboard to return to the beginning. 

 In the Adjust group on the Text Tools Format tab, click Background color  

and choose a color from the palette. 

 
 

  

TIP: When you reselect the 

clip, the text may seem to 

disappear; click the mouse 

on the Preview monitor to 

see the text again. 
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Adjust Text Duration 

 Click the first clip in the storyboard to return to the beginning. 

 Click Text Duration and choose a time from the menu. 

 

 Click Play. 

 Click Pause. 

 

Add a Caption to a Clip 

 Click on shot four – the boy with the binoculars, to select it. 

 Click on the Home tab, find the Add group, and select Caption. 

 Type Where is the boy who looks after the sheep? 

 Use the Font tools on the Text Tools Format tab to make the words look great. 

       

 Click on a choice from the Effects group to apply an effect to the caption. 

 

Edit the Video and Save Your Work 

 
 

 Apply your knowledge to finish editing the video. 

 Click the Movie Maker button or File tab and choose Save project as. 

 Go to the place where you save your work. 

 Name the file edit. 

 Click Save.  

 

Close Movie Maker 

 Click Close.  

Now you know a LOT about Movie Maker 2012! Remember, the goal of 

this assignment is not to make the perfect video, but to learn the 

program. This gives you ideas for making your own modern day nursery 

rhyme. Apply what you know to edit the video. 

TIP: You are changing the amount of time that the text 

shows on the title clip. The words are set to play for 7 

seconds. You can reduce this amount of time, but if 

you want the words or the title clip to play for more 

than 7 seconds, click the Video Tools Edit tab and 

click Duration. Choose a longer time. Now you can go 

back and increase the Text Duration time. 

Students are challenged to 
explore Movie Maker tools. 
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Session 1 Review: Getting to Know Movie Maker 
 

 

1.  
Label the parts of the Movie Maker window. 

 

 

 
 

1. Zoom Time Scale 

2. Preview Monitor 

3. Storyboard 

4. Playback Controls 

5. Ribbon 

/5 

 

2.  Match the terms from the word bank to its definition: 
  

 

Shot Video effects Transition Text overlay 

Frame Import Narration  

 

a) One piece of action in a shot. Frame 

b) A single take that creates one video clip. Shot 

c) Words that are laid over a shot. Text overlay 

d) Special effects that change the appearance of a shot. Video effects 

e) An effect that divides one shot from another. Transition 

f) Voice of a narrator talking while the action occurs. Narration 

g) Bring a file from an outside source into a current program. Import 

/7 

 

 

TOTAL        /12 

Review lessons at the end of 
sessions provide activities to check 
and reinforce newly learned skills, 
concepts, and terminology. 
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Session 1 Skill Review: One Picture Digital Story 
 

Make a digital story using only ONE picture! 

 

You can make a digital story WITHOUT having a video camera. Instead, you can 

use a picture to tell a creative and interesting story. TRY IT! 

 

Follow the instructions to make a modern day version of Jack be Nimble. In this story, 

Jack is on a motorcycle and he jumps over a 10 FOOT TALL candle. 

 

Jack be Nimble 

 

Jack be Nimble 

Jack be quick.  
Jack jumped over the candlestick. 

 

 

1.  Open Movie Maker. 

  

2.  On the Home tab, click Add videos and photos. 
 

  

3.  Go to the Drama folder and select the jump image file. 

  

4.  Click Open. 

  

5.  Repeat this step 2 more times so that you have 3 copies of the same picture in 

the storyboard.  
  

6.  Click the Visual Effects tab. 

 
 

  

7.  Select the first image and apply the 3D Ripple effect (Motions and Fades category). 

Select the second image and apply the Warp effect (Motions and Fades category). 

Select the third image and apply the Hue - cycle entire color spectrum effect 

(Motions and Fades category). 

  

8.  Click the Animations tab. Locate the Transitions group. 

 
 

  

9.  Select the second image and apply the Spin transition (Reveals group). 

Select the third image and apply the Shatter top–left transition (Shatters category). 

  

10.  Add a caption to the first image. 

Click the Home tab and select Caption. 

Type Jack be NIMBLE!  

In the Effects group, select Zoom in – big (Zoom category). 

 

 

 

Skill Reviews are activities for 
students to practice the technical 
skills learned in the previous 
session. 



SAMPLE
TECHNODRAMA 

 

1-22  TECHNOKIDS INC. 

 

11.  Add a caption to the second image. 

On the Home tab, select Caption. 

Type Jack be QUICK!  

In the Effects group, select Stretch (Emphasis category). 

 

 

  

12.  Add a caption to the third image. 

On the Home tab, select Caption. 

Type Jack jumped over the 10 foot tall candlestick! 

Use the mouse to widen the text box by dragging the side sizing handles to the width 

of the picture. Select the text and adjust the font size so that it all fits on one line. 

In the Effects group, select Scroll (Scroll category). 

 

  

 13.  View the story by clicking the Play button in the Preview Monitor. 

  

14.  Click the Movie Maker button or File tab and choose Save project as. 

Go to your student folder. Save the file as jump edit.  

  

15.  Save the file as a movie.  

Click the Movie Maker button or File tab and choose Save movie. 

Select Recommended for this project. 

Choose a location to save the file and click Save. 

 

  

16.  Close Movie Maker. 

 

NOTE: View a sample of this file in the Session 1 Skill Review folder. 

 

 



SAMPLE
TECHNODRAMA  SESSION 1 

 

TECHNOKIDS INC.  1-23 

Session 1 Extension Activity: Thinking About Nursery Rhymes 
 

Thinking About Nursery Rhymes 

 

You have likely heard many nursery rhymes, but have you ever really "listened" to them? They 

are very silly. Read each of the nursery rhymes and answer the questions. 

 

 
 

1.  Do you think the wife liked living in a pumpkin? 

  

 

2.  How could the wife even fit into a pumpkin? 

  

 

3.  What would you do if you were Peter's wife? 

  

 

 

 
 

1.  Do you think what Wee Willie Winkie is doing is a good idea? Why or why not? 

  

 

2.  Why is Wee Willie Winkie wearing pajamas instead of clothes? 

  

 

3.  How would you feel if someone knocked at your door to see if you were in bed? 

  

 

Peter, Peter, Pumpkin Eater 

 

Peter, Peter, pumpkin eater, 

Had a wife but couldn't keep her. 

He put her in a pumpkin shell, 

And there he kept her, very well. 

Wee Willie Winkie 

 

Wee Willie Winkie, runs through the town. 

Upstairs and down stairs, in his nightgown. 

Rapping at the windows, crying through the locks, 

"Are the children all in bed, for now it's eight o'clock". 

Extension Activities at the end 
of sessions provide optional 
enrichment challenges. 




